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Question Number : 1 Question Id : 146587101 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In which district of Chhattisgarh is India’s only active tin mine located?
Options :
146587401.  Balod
146587402.  Janjgir
146587403.  Korba
146587404.  Bastar
   
Question Number : 1 Question Id : 146587101 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
भारत की एकमात्र सक्रिय टिन खदान छत्तीसगढ़ के  किस जिले में स्थित है?
Options :
146587401.  बालोद
146587402.  जांजगिर
146587403.  कोरबा



146587404.  बस्तर
   
Question Number : 2 Question Id : 146587102 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
'Chhattisgarh' derives its name from the 36 garhs (forts) on a river, 18 garhs to the north of that river and another 18 garhs to the South of that
river. What is the name of the river on which these 36 garhs lie?
Options :
146587405.  Mahanadi
146587406.  Shivnath
146587407.  Hasdeo
146587408.  Indravati
   
Question Number : 2 Question Id : 146587102 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
‘छत्तीसगढ़’ के  नाम की व्युत्पत्ति एक नदी पर स्थित 36 गढ़ों (किलों) से हुई है, जिसमें से 18 किले उस नदी के  उत्तर में और 18 किले उसके  दक्षिण में थे। उस
नदी का क्या नाम है, जिसपर ये किले स्थित हैं?
Options :
146587405.  महानदी
146587406.  शिवनाथ
146587407.  हसदेव
146587408.  इंद्रावती
   
Question Number : 3 Question Id : 146587103 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Name the foreign traveler who visited Chhattisgarh in 7th century.
Options :
146587409.  Fa-Hien
146587410.  Ptolemy
146587411.  Al-Masudi



146587412.  Hiuen-Tsang
   
Question Number : 3 Question Id : 146587103 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
उस विदेशी यात्री का नाम बताइए जो 7वीं  शताब्दी में छत्तीसगढ़ आया था।
Options :
146587409.  फा-हियेन (Fa-Hien)
146587410.  टॉलेमी (Ptolemy)
146587411.  अल मासुदी (Al-Masudi)
146587412.  ह्वेन-त्सांग (Hiuen-Tsang)
   
Question Number : 4 Question Id : 146587104 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The ancient deposits of Chhattisgarh and Jain religion memorials are found at:
Options :
146587413.  Malhar, Sirpur Maheshpur and Arang
146587414.  Rajim, Sita Bengra and Jogibhatta
146587415.  Deepadih and Dantewada
146587416.  Dongargarh 
   
Question Number : 4 Question Id : 146587104 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ और जैन धर्म के  स्मारकों के  प्राचीन भंडार ___________ में पाए जाते हैं।
Options :
146587413.  मल्हार, सिरपुर महेशपुर और आरंग
146587414.  राजिम, सीता बंगरा और जोगीभट्टा
146587415.  दीपाडीह और दंतेवाडा
146587416.  डोंगरगढ़



   
Question Number : 5 Question Id : 146587105 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Mahatma Gandhi visited Chhattisgarh for the first time in 1920 after people's movement in connection with:
Options :
146587417.  house arrest of the ruler of Bijapur by the British
146587418.  ban on mining in Mohra area of Raipur
146587419.  imposition of tax on Kandel Canal in Dhamtari
146587420.  restriction on agriculture in Malgaon village of Kanker
   
Question Number : 5 Question Id : 146587105 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
_______ से जुड़े जनांदोलन के  बाद महात्मा गांधी ने 1920 में पहली बार छत्तीसगढ़ का दौरा किया था।
Options :
146587417.  अंग्रेजों द्वारा बीजापुर के  शासक की गिरफ्तारी
146587418.  रायपुर के  मोहरा क्षेत्र में खनन पर रोक
146587419.  धमतरी में कं देल नहर पर कर आरोपण
146587420.  कांके र के  मालगाँव ग्राम में खेती पर प्रतिबंध
   
Question Number : 6 Question Id : 146587106 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following festivals of Chhattisgarh was celebrated right after the festival of Raksha Bandhan, in the year 2021?
Options :
146587421.  Kajari Teej
146587422.  Surhul
146587423.  Chakradhar festival
146587424.  Rajim Lochan Mahotsav
   
Question Number : 6 Question Id : 146587106 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option



Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से वर्ष 2021 में, रक्षाबंधन त्यौहार के  ठीक बाद छत्तीसगढ़ में किस त्यौहार को मनाया गया था?
Options :
146587421.  कजरी तीज
146587422.  सरहुल
146587423.  चक्रधर उत्सव
146587424.  राजिम लोचन महोत्सव
   
Question Number : 7 Question Id : 146587107 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following dialects is generally spoken in Northern Chhattisgarh area?
Options :
146587425.  Kedri Chhattisgarhi
146587426.  Khaltahi Chhattisgarhi
146587427.  Rakshahun Chhattisgarhi
146587428.  Bhandar Chhattisgarhi
   
Question Number : 7 Question Id : 146587107 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सी बोली आमतौर पर उत्तरी छत्तीसगढ़ क्षेत्र में बोली जाती है?
Options :
146587425.  के दरी छत्तीसगढ़ी
146587426.  खलताही छत्तीसगढ़ी
146587427.  रक्षाहून छत्तीसगढ़ी
146587428.  भंडार छत्तीसगढ़ी
   
Question Number : 8 Question Id : 146587108 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0
In which district of Chhattisgarh is the Chandaini Gonda dance mainly practiced?
Options :
146587429.  Bastar
146587430.  Narainpur
146587431.  Dantewada
146587432.  Kanker
   
Question Number : 8 Question Id : 146587108 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ के  किस जिले में चंदैनी गोंदा नृत्य मुख्य रूप से प्रचलित है?
Options :
146587429.  बस्तर
146587430.  नारायणपुर
146587431.  दंतेवाड़ा
146587432.  कांके र
   
Question Number : 9 Question Id : 146587109 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which dance form of Chhattisgarh is also called 'Parrot Dance'?
Options :
146587433.  Raut Nacha
146587434.  Suwa/Sua dance
146587435.  Kari dance
146587436.  Hareli dance
   
Question Number : 9 Question Id : 146587109 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ के  किस नृत्य रूप को 'तोता नृत्य' भी कहा जाता है?



Options :
146587433.  राउत नाचा
146587434.  सुवा/सुआ नृत्य
146587435.  करी नृत्य
146587436.  हरेली नृत्य
   
Question Number : 10 Question Id : 146587110 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Name the noted cartoonist who started the monthly cartoon magazine 'Cartoon Watch'.
Options :
146587437.  Triambak Sharma
146587438.  Harish Chandra Shukla 'Kak'
146587439.  Satish Acharya
146587440.  Shekhar Gurera
   
Question Number : 10 Question Id : 146587110 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
उस प्रसिद्ध कार्टू  निस्ट का नाम क्या है, जिसने मासिक कार्टू न पत्रिका 'कार्टू न वॉच' की शुरुआत की थी?
Options :
146587437.  त्र्यंबक शर्मा
146587438.  हरीश चंद्र शुक्ल 'काक'
146587439.  सतीश आचार्य
146587440.  शेखर गुरे रा
   
Question Number : 11 Question Id : 146587111 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Each gram panchayat area in Chhattisgarh is divided into not less than ______ wards.
Options :



146587441.  seven
146587442.  ten
146587443.  eleven
146587444.  thirteen
   
Question Number : 11 Question Id : 146587111 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ में प्रत्येक ग्राम पंचायत क्षेत्र को कम से कम ______ वार्डों में विभाजित किया गया है।
Options :
146587441.  सात
146587442.  दस
146587443.  ग्यारह
146587444.  तेरह
   
Question Number : 12 Question Id : 146587112 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
How many districts of Chhattisgarh are covered as the "Schedule V" areas?
Options :
146587445.  Five
146587446.  Seven
146587447.  Nine
146587448.  Eleven
   
Question Number : 12 Question Id : 146587112 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ के  कितने जिले "अनुसूची V" क्षेत्र के  अन्तर्गत आते हैं?
Options :
146587445.  पाँच



146587446.  सात
146587447.  नौ
146587448.  ग्यारह
   
Question Number : 13 Question Id : 146587113 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
At least ______ meeting(s) of the Gram Sabha must be held every three months in tribal-dominated panchayats in Chhattisgarh.
Options :
146587449.  one
146587450.  two
146587451.  three
146587452.  four
   
Question Number : 13 Question Id : 146587113 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ में आदिवासी बहुल पंचायतों में हर तीन महीने में ग्राम सभा की कम से कम ________ बैठक/ बैठकें  आयोजित की जानी चाहिए।
Options :
146587449.  एक
146587450.  दो
146587451.  तीन
146587452.  चार
   
Question Number : 14 Question Id : 146587114 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In Chhattisgarh, who presides over the gram sabha meetings of tribal-dominated panchayats?
Options :
146587453.  Sarpanch
146587454.  Up-Sarpanch



146587455.  Member of Scheduled Tribe
146587456.  District Collector
   
Question Number : 14 Question Id : 146587114 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ में, आदिवासी बहुल पंचायतों की ग्राम सभा की बैठकों की अध्यक्षता कौन करता है?
Options :
146587453.  सरपंच
146587454.  उप-सरपंच
146587455.  अनुसूचित जनजाति का सदस्य
146587456.  जिला कलेक्टर
   
Question Number : 15 Question Id : 146587115 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
As per the Champion & Seth Classification of Forest Types (1968), the forests in Chhattisgarh belong to two Type droups, which are further
divided into _______ Forest Types.
Options :
146587457.  Five
146587458.  Seven
146587459.  Ten
146587460.  Twelve
   
Question Number : 15 Question Id : 146587115 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
वन प्रकारों के  चैंपियन और सेठ वर्गीकरण (1968) के  अनुसार, छत्तीसगढ़ में वन दो प्रकार के  समूहों से संबंधित हैं, जिन्हें आगे _______ वन प्रकारों में विभाजित
किया गया है।
Options :
146587457.  पाँच
146587458.  सात



146587459.  दस
146587460.  बारह
   
Question Number : 16 Question Id : 146587116 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In terms of area with forest cover, what is the rank of Chhattisgarh state in comparison to other Indian states?
Options :
146587461.  First
146587462.  Second
146587463.  Third
146587464.  Fourth
   
Question Number : 16 Question Id : 146587116 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
वन आच्छादन वाले क्षेत्र के  संदर्भ में, अन्य भारतीय राज्यों की तुलना में छत्तीसगढ़ राज्य कौन से स्थान पर है?
Options :
146587461.  प्रथम
146587462.  द्वितीय
146587463.  तृतीय
146587464.  चतुर्थ
   
Question Number : 17 Question Id : 146587117 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
As per the 2019 report of Department of Industrial Policy and Promotion (DIPP), what is the rank of Chhattisgarh state in Ease of Doing
Business in comparison to other Indian states?
Options :
146587465.  Fourth
146587466.  Sixth
146587467.  Eighth



146587468.  Tenth
   
Question Number : 17 Question Id : 146587117 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
औद्योगिक नीति और संवर्धन विभाग (Industrial Policy and Promotion (DIPP) की रिपोर्ट-2019 के  अनुसार, अन्य भारतीय राज्यों की तुलना में ईज ऑफ
डू इंग बिजनेस में छत्तीसगढ़ राज्य का रैंक क्या है?
Options :
146587465.  चतुर्थ
146587466.  छठा
146587467.  आठवाँ
146587468.  दसवां
   
Question Number : 18 Question Id : 146587118 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which steel plant located in Chhattisgarh is India's sole producer & supplier of world class rails for Indian Railways?
Options :
146587469.  Mahamaya Steel Industries
146587470.  NDMC Iron and Steel Plant
146587471.  JSPL Raigarh
146587472.  Bhilai Steel Plant (BSP) 
   
Question Number : 18 Question Id : 146587118 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ में स्थित कौन सा इस्पात संयंत्र भारतीय रेलवे के  लिए विश्व स्तरीय रेल का भारत का एकमात्र उत्पादक और आपूर्तिकर्ता है?
Options :
146587469.  महामाया स्टील इंडस्ट्री ज
146587470.  एनडीएमसी आयरन एं ड स्टील प्लांट
146587471.  जेएसपीएल रायगढ़



146587472.  भिलाई इस्पात प्लांट (बीएसपी)
   
Question Number : 19 Question Id : 146587119 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The demand for a separate state of Chhattisgarh was supported by which of the following parties?

Options :
146587473.  Congress and Bharatiya Janata Party
146587474.  Bharatiya Janata Party and Aarakshan Virodhi Party
146587475.  Congress and Bahujan Samaj Party
146587476.  Bharatiya Janata Party and Rastriya Jantantrik Dal
   
Question Number : 19 Question Id : 146587119 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ को अलग राज्य बनाने की मांग को निम्नलिखित में से किन दलों ने समर्थन दिया था?
Options :
146587473.  कांग्रेस और भारतीय जनता पार्टी
146587474.  भारतीय जनता पार्टी और आरक्षण विरोधी पार्टी
146587475.  कांग्रेस और बहुजन समाज पार्टी
146587476.  भारतीय जनता पार्टी और राष्ट्री य जनतांत्रिक दल
   
Question Number : 20 Question Id : 146587120 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which among the following is the longest dam in Chhattisgarh?
Options :
146587477.  Dudhawa dam
146587478.  Tandula dam
146587479.  Rabo dam



146587480.  Gangrel dam
   
Question Number : 20 Question Id : 146587120 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ में निम्नलिखित में से सबसे अधिक लम्बा बाँध कौन सा है?
Options :
146587477.  दुधवा बाँध
146587478.  तांदुला बाँध
146587479.  राबो बाँध
146587480.  गंगरेल बाँध
   
Question Number : 21 Question Id : 146587121 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which one of the following dance forms is NOT originated from Chhattisgarh?
Options :
146587481.  Saila
146587482.  Karma
146587483.  Panthi
146587484.  Kachari
   
Question Number : 21 Question Id : 146587121 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से किस नृत्य शैली की उत्पत्ति छत्तीसगढ़ से नहीं  हुई है?
Options :
146587481.  सैला
146587482.  कर्मा
146587483.  पंथी
146587484.  कचरी



   
Question Number : 22 Question Id : 146587122 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
What type of silk is the famous 'Kosa' of Chhattisgarh?
Options :
146587485.  Muga silk
146587486.  Spider silk
146587487.  Mussel silk
146587488.  Tussar silk
   
Question Number : 22 Question Id : 146587122 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ का प्रसिद्ध 'कोसा' किस प्रकार का रेशम है?
Options :
146587485.  मूगा रेशम
146587486.  स्पाइडर रेशम
146587487.  मसल रेशम
146587488.  तसर रेशम
   
Question Number : 23 Question Id : 146587123 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
The production of Tendu leaves in the state of Chhattisgarh is nearly ______ of the total Tendu leaves production of the country.

Options :
146587489.  10%
146587490.  20%
146587491.  40%
146587492.  50%



   
Question Number : 23 Question Id : 146587123 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ राज्य में तेंदू पत्ता का उत्पादन देश के  कु ल तेंदू पत्ता उत्पादन का लगभग ______ है।
Options :
146587489.  10%
146587490.  20%
146587491.  40%
146587492.  50%
   
Question Number : 24 Question Id : 146587124 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Article 243-i of the Indian constitution provides for _______.
Options :
146587493.  Audit of accounts of panchayats
146587494.  Duration of panchayats
146587495.  Composition of panchayats
146587496.  Constitution of state finance commission
   
Question Number : 24 Question Id : 146587124 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
भारतीय संविधान का अनुच्छे द 243-i _______ का प्रावधान करता है।
Options :
146587493.  पंचायतों के  खातों की लेखापरीक्षा
146587494.  पंचायतों की अवधि
146587495.  पंचायतों की संरचना
146587496.  राज्य वित्त आयोग का गठन
   



Question Number : 25 Question Id : 146587125 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which river is known as “Life Line of Chhattisgarh"?
Options :
146587497.  Shivnath
146587498.  Mahanadi
146587499.  Indravati
146587500.  Hasdeo
   
Question Number : 25 Question Id : 146587125 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
छत्तीसगढ़ की किस नदी को "छत्तीसगढ़ की जीवन रेखा" के  रूप में जाना जाता है?
Options :
146587497.  शिवनाथ
146587498.  महानदी
146587499.  इंद्रावती
146587500.  हसदेव
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Question Number : 26 Question Id : 146587126 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following device is used to convert paper documents into an electronic format for storing purposes?
Options :
146587501.  Scanner
146587502.  Mouse
146587503.  Microphone
146587504.  Track ball
   
Question Number : 26 Question Id : 146587126 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
संग्रहण के  उद्देश्य से कागजी दस्तावेजों को इलेक्ट्रॉ निक प्रारूप में रखने के  लिए निम्न में से किसका उपयोग किया जाता है?
Options :
146587501.  स्कै नर
146587502.  माउस
146587503.  माइक्रोफ़ोन
146587504.  ट्रै क बॉल
   
Question Number : 27 Question Id : 146587127 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT an input device?
Options :
146587505.  Mouse
146587506.  Digitizer
146587507.  Projector
146587508.  Image scanner
   



Question Number : 27 Question Id : 146587127 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा एक इनपुट डिवाइस नहीं  है?
Options :
146587505.  माउस
146587506.  डिजिटाइज़र
146587507.  प्रोजेक्टर
146587508.  इमेज़ स्कै नर
   
Question Number : 28 Question Id : 146587128 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is/are TRUE?

(i) Laser printers are always monochrome.
(ii) Laser printers are also called character printers.
Options :
146587509.  Only (i)
146587510.  Only (ii)
146587511.  Both (i) and (ii)
146587512.  Neither (i) nor (ii)
   
Question Number : 28 Question Id : 146587128 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा/से कथन सत्य है/हैं?

(i) लेजर प्रिंटर हमेशा मोनोक्रोम होते हैं।
(ii) लेजर प्रिंटर को कै रेक्टर प्रिंटर भी कहा जाता है।
Options :
146587509.  के वल (i)
146587510.  के वल (ii)



146587511.  (i) और (ii) दोनों
146587512.  न तो (i) और ना ही (ii)
   
Question Number : 29 Question Id : 146587129 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
With respect to input-output devices, the term MICR stands for:
Options :
146587513.  Magnetic Input Character Recognition
146587514.  Memory Ink Character Recognition
146587515.  Magnetic Ink Character Recognition
146587516.  Memory Input Character Recognition
   
Question Number : 29 Question Id : 146587129 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
इनपुट-आउटपुट डिवाइस के  संदर्भ में, MICR शब्द का पूर्ण रूप क्या है?
Options :
146587513.  Magnetic Input Character Recognition (मैग्नेटिक इनपुट कै रेक्टर रिकॉग्निशन)
146587514.  Memory Ink Character Recognition (मेमोरी इंक कै रेक्टर रिकॉग्निशन)
146587515.  Magnetic Ink Character Recognition (मैग्नेटिक इंक कै रेक्टर रिकॉग्निशन)
146587516.  Memory Input Character Recognition (मेमोरी इनपुट कै रेक्टर रिकॉग्निशन)
   
Question Number : 30 Question Id : 146587130 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following is a sequential data access device?
Options :
146587517.  RAM
146587518.  Hard disk
146587519.  ROM



146587520.  Magnetic tape
   
Question Number : 30 Question Id : 146587130 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा अनुक्रमिक डेटा एक्सेस डिवाइस है?
Options :
146587517.  RAM
146587518.  हार्ड डिस्क (Hard disk)
146587519.  ROM
146587520.  मैग्नेटिक टेप
   
Question Number : 31 Question Id : 146587131 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following options best describes the truthfulness of the below statements?

(i) Cache memory is faster than main memory.
(ii) Main memory is faster than hard disk.
Options :
146587521.  (i) - TRUE; (ii) - TRUE
146587522.  (i) - TRUE; (ii) - FALSE
146587523.  (i) - FALSE; (ii) - TRUE
146587524.  (i) - FALSE; (ii) - FALSE
   
Question Number : 31 Question Id : 146587131 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
दिए गए विकल्पों में से कौन सा विकल्प, निम्नलिखित कथनों की सत्यता का सर्वोत्तम विवरण प्रस्तुत करता है?

(i) कै श मेमोरी, मेन मेमोरी से तेज होती है।
(ii) मेन मेमोरी हार्ड डिस्क से तेज होती है।
Options :



146587521.  (i) - सत्य; (ii) – सत्य
146587522.  (i) - सत्य; (ii) – असत्य
146587523.  (i) - असत्य; (ii) – सत्य
146587524.  (i) - असत्य; (ii) – असत्य
   
Question Number : 32 Question Id : 146587132 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In Microsoft Word 2013, the keyboard shortcut Ctrl + Alt + PgDown is used to go to the:
Options :
146587525.  next page
146587526.  previous page
146587527.  next word
146587528.  last character displayed in the window
   
Question Number : 32 Question Id : 146587132 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Microsoft Word 2013 में कीबोर्ड शॉर्टकट Ctrl + Alt + PgDown का उपयोग ________ पर जाने में किया जाता है।
Options :
146587525.  अगले पृष्ठ (next page)
146587526.  पिछले पृष्ठ (previous page)
146587527.  अगले शब्द (next word)
146587528.  विंडो में प्रदर्शित अंतिम संप्रतीक (last character)
   
Question Number : 33 Question Id : 146587133 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In Microsoft Word, which of the following keyboard shortcuts runs the spelling and grammar check?
Options :
146587529.  F7



146587530.  F8
146587531.  F9
146587532.  Shift + F7
   
Question Number : 33 Question Id : 146587133 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Microsoft Word में, निम्नलिखित में से कौन सा कीबोर्ड शॉर्टकट spelling and grammar जाँच को रन करता है?
Options :
146587529.  F7
146587530.  F8
146587531.  F9
146587532.  Shift + F7
   
Question Number : 34 Question Id : 146587134 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In Microsoft Word 2013, if gridlines are visible, how would you disable them?
Options :
146587533.  Go to Page Layout -> Uncheck 'Gridlines'
146587534.  Go to Review -> Uncheck 'Gridlines'
146587535.  Go to View -> Uncheck 'Gridlines'
146587536.  Go to Layout -> Uncheck 'Gridlines'
   
Question Number : 34 Question Id : 146587134 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Microsoft Word 2013 में, यदि ग्रिडलाइन दिखाई देती हैं, तो आप उन्हें कै से डिसेबल करेंगे?
Options :
146587533.  Page Layout (पेज लेआउट) पर जाएँ  -> 'Gridlines (ग्रिडलाइन्स)' को अनचेक करें
146587534.  Review (रिव्यू) पर जाएँ  -> 'Gridlines (ग्रिडलाइन्स)' को अनचेक करें



146587535.  View (व्यू) पर जाएँ  -> 'Gridlines (ग्रिडलाइन्स)' को अनचेक करें
146587536.  Layout (लेआउट) पर जाएँ  -> 'Gridlines (ग्रिडलाइन्स)' को अनचेक करें
   
Question Number : 35 Question Id : 146587135 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
In Microsoft Word 2013, within the 'Language' menu group of the 'Review' tab there are ____ options available under the 'Translate' option.
Options :
146587537.  three
146587538.  four
146587539.  two
146587540.  five
   
Question Number : 35 Question Id : 146587135 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Microsoft Word 2013 में, 'Review (रिव्यू)' के  'Language (लैंग्वेज)' मेनू ग्रुप में 'Translate (ट्रा न्सलेट)' विकल्प के  तहत ____ विकल्प उपलब्ध होते हैं।
Options :
146587537.  तीन
146587538.  चार
146587539.  दो
146587540.  पाँच
   
Question Number : 36 Question Id : 146587136 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
You want to run a mail merge in Microsoft Word using an Excel spreadsheet. Arrange the following steps in the CORRECT sequence for doing
so.

a) In Microsoft Word, choose 'File' -> New -> Blank document.
b) Browse to your Excel spreadsheet -> Choose 'Open'.
c) On the Mailings tab, in the 'Start Mail Merge' group, choose 'Start Mail Merge' -> Choose the kind of merge you want to run.



d) Choose 'Select Recipients' -> Use an Existing List.
e) If Microsoft Word prompts you, choose 'Sheet1$' -> Click 'OK'.
Options :
146587541.  a); c); d); b); e)
146587542.  a); d); c); b); e)
146587543.  a); c); b); d); e)
146587544.  a); c); d;) e); b)
   
Question Number : 36 Question Id : 146587136 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
आप Excel spreadsheet (स्प्रेडशीट) का उपयोग करके  Microsoft Word में एक मेल मर्ज (mail merge) चलाना चाहते हैं। ऐसा करने के  लिए दिए गए चरणों
को सही क्रम में व्यवस्थित करें।

a) Microsoft Word में 'File' -> New -> Blank document चुनें।
b) अपनी Excel spreadsheet ब्राउज़ करें  -> ' Open (ओपन)' चुनें।
c) मेलिंग टैब पर, 'Start Mail Merge (स्टार्ट मेल मर्ज)' ग्रुप में, 'Start Mail Merge (स्टार्ट मेल मर्ज)’ चुनें -> उस प्रकार का मर्ज चुनें जिसे आप रन करना चाहते
हैं।
d) 'Select Recipients (सेलेक्ट रिसिपेन्ट)' चुनें -> एक Existing List का उपयोग करें।
e) यदि Microsoft Word आपको संके त देता है, तो 'Sheet1 $' -> चुनें, 'OK' पर क्लिक करें।
Options :
146587541.  a); c); d); b); e)
146587542.  a); d); c); b); e)
146587543.  a); c); b); d); e)
146587544.  a); c); d;) e); b)
   
Question Number : 37 Question Id : 146587137 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Which of the following is an operating system?
Options :
146587545.  Linux
146587546.  Microsoft Excel



146587547.  Paint
146587548.  Microsoft Access
   
Question Number : 37 Question Id : 146587137 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
निम्नलिखित में से कौन सा एक ऑपरे टिंग सिस्टम है?
Options :
146587545.  Linux
146587546.  Microsoft Excel
146587547.  Paint
146587548.  Microsoft Access
   
Question Number : 38 Question Id : 146587138 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
________ is a type of software with source code that anyone can inspect, modify and enhance. This software is available free of cost.
Options :
146587549.  Firmware
146587550.  Freeware
146587551.  Shareware
146587552.  Open-source software
   
Question Number : 38 Question Id : 146587138 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
सोर्स कोड के  साथ _________ एक प्रकार का सॉफ्टवेयर है जिसका कोई भी निरीक्षण, संशोधन और विस्तार कर सकता है। यह सॉफ्टवेयर मुफ्त में उपलब्ध
है।
Options :
146587549.  फर्मवेयर (Firmware)
146587550.  फ्रीवेयर (Freeware)
146587551.  शेयरवेयर (Shareware)



146587552.  ओपन सोर्स सॉफ्टवेयर (Open-source software)
   
Question Number : 39 Question Id : 146587139 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0

Options :
146587553.  a – ii; b – iv; c – i; d – iii
146587554.  a – iii; b – iv; c – i; d – ii
146587555.  a – ii; b – iii; c – i; d – iv
146587556.  a – ii; b – iv; c – iii; d – i
   
Question Number : 39 Question Id : 146587139 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



Options :
146587553.  a – ii; b – iv; c – i; d – iii
146587554.  a – iii; b – iv; c – i; d – ii
146587555.  a – ii; b – iii; c – i; d – iv
146587556.  a – ii; b – iv; c – iii; d – i
   
Question Number : 40 Question Id : 146587140 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
SNOBOL language was widely used for _________.
Options :
146587557.  string manipulation
146587558.  database management
146587559.  scientific computation
146587560.  system programming
   
Question Number : 40 Question Id : 146587140 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
SNOBOL भाषा का उपयोग मुख्यतः  _________ के  लिए हुआ था।
Options :



146587557.  स्ट्रिं ग मैनीपुलेशन
146587558.  डेटाबेस मैनेजमेंट
146587559.  साइं टिफिक कम्प्यूटेशन
146587560.  सिस्टम प्रोग्रामिंग
   
Question Number : 41 Question Id : 146587141 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0

Options :
146587561.  a – ii; b – i; c – iv; d – iii
146587562.  a – i; b – ii; c – iv; d – iii
146587563.  a – ii; b – iii; c – iv; d – i
146587564.  a – ii; b – i; c – iii; d – iv
   
Question Number : 41 Question Id : 146587141 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



Options :
146587561.  a – ii; b – i; c – iv; d – iii
146587562.  a – i; b – ii; c – iv; d – iii
146587563.  a – ii; b – iii; c – iv; d – i
146587564.  a – ii; b – i; c – iii; d – iv
   
Question Number : 42 Question Id : 146587142 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
What is the full form of AJAX?
Options :
146587565.  Asynchronous JavaScript and XML
146587566.  Asynchronous Java and XML
146587567.  Asynchronous JSON and Extension
146587568.  Await JavaScript and XML
   
Question Number : 42 Question Id : 146587142 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
AJAX का पूर्ण रूप क्या है?
Options :



146587565.  Asynchronous JavaScript and XML (एसिंगक्रनस जावा स्क्रिप्ट एण्ड XML)
146587566.  Asynchronous Java and XML (एसिंगक्रनस जावा एण्ड XML)
146587567.  Asynchronous JSON and Extension (एसिंगक्रनस JSON एण्ड एक्सटेंशन)
146587568.  Await JavaScript and XML (अवैट जावा स्क्रिप्ट एण्ड XML)
   
Question Number : 43 Question Id : 146587143 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
What is Node.js?
Options :
146587569.  An open source runtime environment
146587570.  An operating system
146587571.  An application program for notes processing
146587572.  A driver program
   
Question Number : 43 Question Id : 146587143 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Node.js क्या है?
Options :
146587569.  ओपन सोर्स रनटाइम एनवायरनमेंट
146587570.  ऑपरे टिंग सिस्टम
146587571.  नोट्स प्रोसेसिंग के  लिए एप्लिके शन प्रोग्राम
146587572.  एक ड्रा ईवर प्रोग्राम
   
Question Number : 44 Question Id : 146587144 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0



Options :
146587573.  a – ii; b – i; c – iv; d – iii
146587574.  a – i; b – ii; c – iv; d – iii
146587575.  a – ii; b – iii; c – iv; d – i
146587576.  a – ii; b – iv; c – i; d – iii
   
Question Number : 44 Question Id : 146587144 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0

Options :
146587573.  a – ii; b – i; c – iv; d – iii
146587574.  a – i; b – ii; c – iv; d – iii
146587575.  a – ii; b – iii; c – iv; d – i



146587576.  a – ii; b – iv; c – i; d – iii
   
Question Number : 45 Question Id : 146587145 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Secure Shell provides a secure session when logging into a remote machine. It uses port number _____.
Options :
146587577.  21
146587578.  22
146587579.  23
146587580.  24
   
Question Number : 45 Question Id : 146587145 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
रिमोट मशीन में लॉग इन करते समय सिक्योर शेल एक सुरक्षित सत्र प्रदान करता है। यह पोर्ट नंबर _____ का उपयोग करता है।
Options :
146587577.  21
146587578.  22
146587579.  23
146587580.  24
   
Question Number : 46 Question Id : 146587146 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
___________ protocol is used for receiving mail.
Options :
146587581.  Post Office Protocol 3
146587582.  Dynamic Host Control Protocol
146587583.  Routing Information Protocol
146587584.  Address Resolution Protocol



   
Question Number : 46 Question Id : 146587146 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
मेल प्राप्त करने के  लिए _______ प्रोटोकॉल का उपयोग किया जाता है।
Options :
146587581.  पोस्ट ऑफिस प्रोटोकॉल 3
146587582.  डायनेमिक होस्ट कं ट्रो ल प्रोटोकॉल
146587583.  रूटिंग इन्फोर्मेशन प्रोटोकॉल
146587584.  एड्रे स रेज़लूशन प्रोटोकॉल
   
Question Number : 47 Question Id : 146587147 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
Repetition of worthless text in the form of messages or mails is known as _______.
Options :
146587585.  spam
146587586.  cookies
146587587.  firewall
146587588.  phishing
   
Question Number : 47 Question Id : 146587147 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
संदेश या मेल के  रूप में अनुपयोगी टेक्स्ट की पुनरावृत्ति को _____ कहते हैं।
Options :
146587585.  स्पैम
146587586.  कु कीज़
146587587.  फ़ायरवॉल
146587588.  फिशिंग
   



Question Number : 48 Question Id : 146587148 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
___________ is an unreliable, connectionless protocol.
Options :
146587589.  User Datagram Protocol
146587590.  telnet
146587591.  rlogin
146587592.  ftp
   
Question Number : 48 Question Id : 146587148 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
__________ एक अविश्वसनीय, कनेक्शन रहित प्रोटोकॉल है।
Options :
146587589.  यूजर डाटाग्राम प्रोटोकॉल
146587590.  टेलनेट
146587591.  rlogin
146587592.  ftp
   
Question Number : 49 Question Id : 146587149 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
___________ is most used for analog television and cable television.
Options :
146587593.  A coaxial cable
146587594.  A twisted pair
146587595.  An electric cable
146587596.  A fiber cable
   
Question Number : 49 Question Id : 146587149 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical



Correct Marks : 1 Wrong Marks : 0
___________ का अधिकतर उपयोग एनालॉग टेलीविजन और के बल टेलीविजन के  लिए किया जाता है।
Options :
146587593.  समाक्षीय (कॉक्सियल) के बल
146587594.  ट्विस्टेड पेयर
146587595.  इलेक्ट्रिक के बल
146587596.  फाइबर के बल
   
Question Number : 50 Question Id : 146587150 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
_______ is a protocol that allows to the user connect to remote computers over a TCP/IP network.
Options :
146587597.  Telnet
146587598.  SMTP
146587599.  POP3
146587600.  HTTP
   
Question Number : 50 Question Id : 146587150 Question Type : MCQ Option Shuffling : Yes Is Question Mandatory : No Option
Orientation : Vertical
Correct Marks : 1 Wrong Marks : 0
_______ एक ऐसा प्रोटोकॉल है जो उपयोगकर्ता को टी.सी.पी./आई.पी. (TCP/IP) नेटवर्क  पर दू रस्थ (रिमोट) कं प्यूटर से कनेक्ट करने की अनुमति देता है।
Options :
146587597.  टेलनेट (Telnet)
146587598.  SMTP
146587599.  POP3
146587600.  HTTP


